Modul Praktikum

MODUL 13
IMPLEMENTASI SOFTCORE PROCESSOR NIOS 11

14.1 Tujuan Praktikum Modul 13 :
Setelah mempraktekkan topik ini, praktikan diharapkan dapat:
1. Dapat mengetahui konsep dasar dari Prosesor NIOS II dan eclipse
2. Dapat mengimplementasikan NIOS II menggunakan DE10-Lite FPGA Board

14.2 Dasar Teori Praktikum Modul 13:
14.2.1 NIOS II
Nios II adalah arsitektur prosesor 32 bit tertanam yang dirancang khusus untuk
keluarga Altera dari rangkaian terintegrasi field-programmable gate array (FPGA). Nios II
menggabungkan banyak peningkatan dibandingkan arsitektur Nios asli, membuatnya lebih
cocok untuk berbagai aplikasi komputasi tertanam, dari pemrosesan sinyal digital (DSP)
hingga kontrol sistem.

14.2.2 Arsitektur Nios 11

Arsitektur Nios II adalah arsitektur soff-core RISC yang diimplementasikan
seluruhnya dalam logika yang dapat diprogram dan blok memori Altera FPGAs. Sifat sofi-
core dari prosesor Nios II memungkinkan perancang sistem menentukan dan menghasilkan
inti Nios II kustom, yang dirancang untuk persyaratan aplikasi spesifiknya.

14.2.3 Eclipse

Eclipse adalah integrated development environment (IDE) yang digunakan dalam
pemrograman komputer, dan merupakan IDE Java yang paling banyak digunakan, berisi
ruang kerja dasar dan sistem plug-in yang dapat dikembangkan untuk menyesuaikan
lingkungan. Eclipse ditulis sebagian besar di Java dan penggunaan utamanya adalah untuk
mengembangkan aplikasi Java, tetapi juga dapat digunakan untuk mengembangkan aplikasi
dalam bahasa pemrograman lain melalui plug-in, termasuk Ada, ABAP, C, C ++, C#, Clojure,
COBOL, D, Erlang, Fortran, Groovy, Haskell, JavaScript, Julia, Lasso, Lua,
NATURAL, Perl, PHP, Prolog, Python, R, Ruby (termasuk kerangka kerja Rubyon Rails),
Rust, Scala, dan Skema. Ini juga dapat digunakan untuk mengembangkan dokumen dengan
LaTeX (melalui plug-in TeXlipse) dan paket untuk perangkat lunak Mathematica.
Lingkungan pengembangan termasuk alat pengembangan Java Eclipse (JDT) untuk Java dan
Scala, Eclipse CDT untuk C /C ++, dan Eclipse PDT untuk PHP.

14.2.1 Arsitektur Eclipse

Eclipse menggunakan plug-in untuk menyediakan semua fungsionalitas di
dalam dan di atas sistem run-time. Sistem run-time didasarkan pada Equinox, sebuah
implementasi dari spesifikasi kerangka kerja OSGi.Selain memungkinkan Platform
Eclipse diperluas menggunakan bahasa pemrograman lain, seperti C dan Python,
kerangka plug-in memungkinkan Platform Eclipse untuk bekerja dengan bahasa
penyusunan huruf seperti LaTeX dan aplikasi jaringan seperti telnet dan sistem
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manajemen basis data . Arsitektur p/ug-in mendukung penulisan ekstensi apa pun yang
diinginkan ke lingkungan, seperti untuk manajemen konfigurasi. Dukungan Java dan
CVS disediakan di Eclipse SDK, dengan dukungan untuk sistem kontrol versi lain yang
disediakan oleh plug-in pihak ketiga.

Eclipse mengimplementasikan elemen kontrol grafis Java foolkit yang disebut
Standard Widget Toolkit (SWT), sedangkan sebagian besar aplikasi Java menggunakan
Java Window Abstract Toolkit (AWT) atau Swing standar Java. Antarmuka pengguna
Eclipse juga menggunakan lapisan antarmuka pengguna grafis perantara yang disebut
JFace, yang menyederhanakan konstruksi aplikasi berdasarkan SWT.

14.3 Lembar Kegiatan Praktikum Modul 14
14.3.1 Alat dan Bahan
1. Laptop yang sudah terinstal software Quartus 18.1 dan NIOS II
2. terasiC DE10-Lite FPGA board

14.3.2 Langkah Praktikum Modul 12

1. Buat Directory baru \pnios2 dan Nama Project pnios2, lalu klik Next.

O New Project Wizard X

Directory, Name, Top-Level Entity

What is the working directory for this project?

‘C:\intelFPGA_liteU 8.1\pnios2 ‘

What is the name of this project?

lpniosZ' J

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly
match the entity name in the design file.

‘pniosz ‘

Use Existing Project Settings...

< Back Finish Cancel Help
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2. Lalu ganti Family ke MAX 10 (DA/DF/DC/SA/SF/SC), kemudian ketikkan di Nama

Filter 10M50DAF484C7G, lalu klik Available Device yang tersedia, kemudian klik Next
sampai ke Finish.
O New Project Wizard
Family, Device & Board Settings

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in 'Available devices' list
Family: MAX 10 (DA/DF/DC/SA/SC) - Package: Any i
Druiee L T Pincount Any -
Target device Core speed grade: Any Y,
Auto dev cted by the Fitter Name filter: 10M50DAF484C7G

© specific device selected in 'Available devices' list @ Show advanced devices
Other: n/a

Available devices:

Core Voltage LEs Total 1/0s GPIOs Memory Bits Embedded multiplier 9-bit elen‘

< Back Next > Finish Cancel Help

3. Kemudian buat file baru dengan cara klik Platform Designer (skematik) qysis (Double
Click).

A0 & ®

Platform Designer

4. Setelah muncul workspace (clock (default)), Masukan komponen.

& Platform Designer - unsaved.gsys* (CAintelFPGA lite\18.1\pnios2\unsaved.qsys) = o X
file Edit System Generate View Iools Help
= P Catalog - o o|| 3= System Contents 33 | AddressMap 22 | Interconnect Requirements 53 -0
: X % = W system: unsaved
Project * luse con.. Name Description Export Clock Base
# New Component... ] B dk.0 Clock Source
lzaw S X o4 dkin Clock Input ok exported
& uasic WCH00s | o ck_in_reset Reset Input reset
! Interface Protocols = dk [Clodk Output dk 0
1 Low Power e clk_reset Reset Output
1} Memory Interfaces and Controlle || _ cli_0.clk
i Processors and Pecipherals Clock Output [clock_source 18.1]
11 Qsys Interconnect >
1 Tri-State Components Associated clock: None (asynchronous)
- University Program
< >
+ Ad
-0
[elunsaved [unsaved.gsya+)|
&) -w= dk
+ »= reset
i ck 0
< >
44t ¥ ¥ current fiter:
[0 Wessages 1| )
Type Path Message
0 Errors, 0 Warnings Generate HDL...  Finish
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5. Tambah komponen Nios ii, ketik nios > scrool kebawah > double klik pada nios prosesor.
Secara otomatis maka modul akan ditambahkan pada workspace.

“ 1P Catalog 2 ] = [=pi=]
, niog X &2
[=-Processors and Peripherals A

[=]-Co-Processors
[=+Nios II Custom Instructions
; Bitswap
Custom Instruction Inter
Custom Instruction Mast
Custom Instruction Slave
Floating Point Hardware
: Floating Point Hardware
[=-Embedded Processors

o SHeeGiaR0CeSSor
* Nios II Processor, v

< >

New... | | Edit... + Add...

I, Hierarct 51?] Device Fam §’|

-ﬂ'l:l]

6. Window workspace nios ii prosesor akan terbuka.

A Nios Il Processor - nios2_gen2_0 X

$&  Nios II Processor

atera_ios2_gen | Documentation |

* Block Diagram
ooyt Main Vectors Caches and Memary Interfoces Arithmetic Instructions MMU and MPU Settings JTAG Debug  Advanced f
* Select an Implementation
: Nios 11 Core: () nios IVe
i O vios WY
S
fpmset_
“ Nios 11/e Nios I1/f
fdobug mom siows e ety U0 S
Features | 1TAG Debug JTAG Dobug
ECC RAM Protection Hardware Multiply / Divide
Instruction/ Data Caches
Tightly-Coupled Masters
£CC RAM Protection
External Interrupt Controller
Register Sets
ey
My
RAM Usage (2 + Options 2 + Options

5. Pease reduce the Instruction Cache Sze, Current Tag Sze 15 0
X o ol
© Error: nlos2_gen2_0: Excepton slove is not specfied. Please select the exception slave

cancel  Finish

7. Terdapat 2 pilihan Nios II core:
Nios I1/ e (ekonomis/s, gratis tidak ada lisensi sama sekali, fitur sedikit) praktikum hanya
menggunakan JTAG saja
Nios I/ f (faster, berbayar, fitur jauh lebih banyak). Pilih ekonomis > finish.

Nios II Core: (@

(O Nios 1/f

Nios II/e Nios II/f
Summary |Resource-optimized 32-bit RISC Performance-optimized 32-bit RISC
Features [JTAG Debug JTAG Debug

ECC RAM Protection Hardware Multiply/Divide

Instruction/Data Caches
Tightly-Coupled Masters

ECC RAM Protection
External Interrupt Controller
Shadow Register Sets

MPU

MMU

RAM Usage |2 + Options 2 + Options
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8. Tambah komponen memori, ketik Memory > scroll kebawah > pilih On-Chip Memory
(RAM or ROM) intel FPGA IP. Terbuka workspace on-chip memory (RAM or ROM).

% 1P Catalog 33] -
, memory X| &
® Avalon-MM Unaligned Burst A
® AXI Bridge
* AXITimeout Bridge
® JTAG to Avalon Master Bridc

[=-On Chip Memory

* Avalon FIFO Memory Intel FPG#
Avalon-ST Dual Clock FIFO
Avalon-ST Multi-Channel Share
Avalon-ST Round Robin Schedt
Avalon-ST Single Clock FIFO

On-Chip Flash Intel FPGA 1P
0n-Chip Memory (RAM or ROMEV]

< >

® ® o 0 00

New... | | Edit... + Add...

9. Tambah memory menjadi 40960 > Finish.

|- size

Enable different width for Dual-port access
Slave S1 Data width: 32 v
Total memory size: 40960 bytes

Minimize memory block usage (may impact fmax)

|~ Read latency

10. Kemudian tambahkan komonen JTAG UART, ketik JTAG > scroll kebawah > pilih
JTAG UART Intel FPGA IP. Terbuka workspace JTAG UART.

“® P Catalog % ] -
{ jtag X K
Library " A

[=}-Basic Functions
[=)-Bridges and Adaptors
[=}-Memory Mapped
* JTAG to Avalon Master Bridc
[=-Simulation; Debug and Verification
[=-Debug and Performance
* Altera Soft Core JTAG IO
* Altera Virtual JTAG
[=Interface Protocols

[=-Serial
LR ITAG UART Intel FPGA 1P v
< >
New... | | Edit.. 4 Add...
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11. Kemudian biarkan sesuai default > finish.

& JTAG UART Intel FPGA IP - jtag_uart_0 X
“ JTAG UART Intel FPGA IP
Megecies  2ltera_avalon_jtag_uart -
[~ Block Diagram S _
Clsho 7 [* Write FIFO (Data from Avalon to JTAG)
e Buffer depth (bytes): (64
IRQ threshold: 8
jtag_uart_0
‘ [ construct using registers instead of memory blocks
g i
eset - Read 1170 (Data from JTAG to Avalon)
alon_jtag_slave Buffer depth (bytes): |64 v
IRQ threshold: s
altera_avalon Jtag_uant

[] construct using registers instead of memory blocks

Warning: jtag_uart_0: JTAG UART IP input clock need to be at least double (2x) the operating frequency of JTAG TCK on board

Cancel Finish

12. tambahkan komponen PIO (paralel input/output), ketik PIO > pilih P1O (Parallel 1/0)
Intel FPGA IP. Terbuka workspace PIO.

“* P Catalog 3% | =

-4 pio X| £
Project

... 8 New Component...
Library

[=Interface Protocols

. [=-PCI Express

[=-QSYS Example Designs
o

[=}-Processors and Peripherals
[=)-Peripherals

LRPIO (Parallel 1/0) Intel FPGA IP

New... | | Edit... + Add...

13. Kemudian pada direction pilih Output > Finish.

A PIO (Parallel 1/0) Intel FPGA IP - pio_0 X

T®  PIO (Parallel 1/0) Intel FPGA 1P
&, oters_avolon o
~ Block Diagram
Show nals d o
- Width (1-32 bits): 8
Orecton e
nput
cik v
Josel hout
'l ion © ouput
s vtemal_connection Output Port Reset Value: 0x0000000000000000

Enable indmidual ba setting/clearing
* kdge capture register

Edge Type:

[+ Interrupt

RQ Type:

Level: Interrupt CPU when any unmasked U0 pin Is logic trve
Edge: Interrupt CPU when any unmasked bit in the edge-capture
rogister is logic true. Avadable when synchronous capture i enabled

* Test bench wiring
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14. Kemudain tambahkan lagi PIO (paralel input/output), pada direction pilih Input >

o o
Finish.
~
Width (1-32 bits): 8
Direction: O sidir
® Input
O mout
O Output

Output Port Reset Value: [0x0000000000000000

15. Setelah itu, Rename pio 0 menjadi led dan pio 1 menjadi switch dengan cara pilih
komponen klik kanan > rename.

Connections >

1 | _irg
][] | =pioo
clk Filter >
resel
st |E3 Edit. Ctrl+E
exter
el 4 Add..
= p':k‘ . . Rename Ctrl+R
resel Duplicate Ctrl+D
h sl | X Remove
|3 petails >
S a Mnovel M. ftrloih’fr-k |
2 led PIO (Parallel 1/0) Intel FPGA IP
clk Clock Input
reset Reset Input
s1 Avalon Memory Mapped Slave

external_connection |Conduit

] PIO (Parallel 1/O) Intel FPGA P

16. Kemudian rename nios2 menjadi sesuai nama project pnios2 dengan cara pilih
komponen klik kanan > rename. Pastikan semua komponen sudah masuk dan di rename.

E- A=

oI 1 Nin

clk Connections

rese

dat: W Filter
inst

irq E3 Edit.
deb 4= Add..
deb . * Rename

17. Kemudian wiring pada connections dengan klik setiap percabangan sambungan atau

simbol "
18. Hubungkan semua clk yang ada pada nios, onchip, jtag, led, switch
19. Hubungkan semua clk reset yang ada pada nios, onchip, jtag, led, switch
20. Hubungkan clk in_reset ke satu bagian saja yaitu debug reset requst
21. Hubungkan data master ke semua sleve agar semua bisa menerima data
22. Hubungkan intruction master hanya terhubung pada s1 onchip memory saja
23. Hubungkan irq prosesor dengan irq jtag (akan muncul dibagian belakang juga) .
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! E: System Contents m Address Map 22 I Interconnect Requirements % I

=

= BE

¥ System: pnios2 Path: clk_0

+ Use Connections Name Description Export
] = ck 0 Clock Source
X = clk_in Clock Input clk
55 ] clk_in_reset Reset Input
= < clk Clock Output
A < clk_reset Reset Output
e B0 pnios2 Nios II Processor
clk Clock Input
- reset Reset Input
—% data_master Avalon Memory Mapped Master
— instruction_master |Avalon Memory Mapped Master
irq Interrupt Receiver
— debug_reset_requ... |Reset Output
debug_mem_slave |Avalon Memory Mapped Slave
custom_instructio... |Custom Instruction Master
B onchip_memory2_0/0n-Chip Memory (RAM or ROM)...
clk1 Clock Input
s1 Avalon Memory Mapped Slave
resetl Reset Input
B jtag_uart_0 JTAG UART Intel FPGA IP
clk Clock Input
reset Reset Input
avalon_jtag_slave |Avalon Memory Mapped Slave
— irq Interrupt Sender
& led PIO (Parallel I/O) Intel FPGA IP
clk Clock Input
reset Reset Input
s1 Avalon Memory Mapped Slave
<A external_connection |Conduit led_external_conne
B switch PIO (Parallel /O) Intel FPGA IP
clk Clock Input
reset Reset Input
s1 Avalon Memory Mapped Slave
<A external_connection |Conduit switch_external_cc
< >

4t % ¥ current filter:

24. Setelah selesai wiring, kemudian pada led dan switch terdapat external_connection,

double click pada Export maka akan muncul penamaannya > enter

external_connection Conduit

B switch PIO (Parallel I/0) Intel FPGA IP
clk Clock Input clk_0
reset Reset Input [clk]
sl Avalon Memory Mapped Slave [clk]

external_connection |Conduit

25. Kemudian simpan file, File > Save >ubah nama file pnios 2 (sesuai nama file quartusnya)
> Close

7Fi|e Edit System Generate View Tools Help

New System...
New Component...

Open...

Save

Save As..
Refresh System

Ctrl+N

Ctrl+O
Ctrl+S

F5

Export System as Platform Designer script (.tcl)
Export System as hw.tcl Component

Browse Project Directory...

Recent Projects

Exit

Alt+F4
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26. Kemudian pilih System > Assign Base Address

System Generate View Tools Help
Upgrade IP Cores...

Assign Base Addresses

Assign Interrupt Numbers

Assign Custom Instruction Opcodes
Create Global Reset Network

Show System With Platform Designer Interconnect
Remove Dangling Connections

Import Interface Requirements...

27. Jika masih terdapat error, Double Click pada pnios2 > pilih vektor > pada Reset Vector
Memory pilih On Chip Memory > pada Exception Vector Memory pilih
onchip_memory2_0.s1 > close, sehingga error tidak ada lagi, simpan file Kembali.

System: pnios2  Path: pnios2

Nios II Processor
altera_nios2_gen2

Main Vectors Caches and Memory Interfaces Arithmetic Instructions MMU and MPU Settini

|* Reset Vector

Reset vector memory: onchip_memory2_0.s1 V)
Reset vector offset: pnios2.debug_mem_slave
Reset vedtor: onchip_memory2_0.s1
Absolute
- None
|* Exception Vector
Exception vector memory: onchip_memory2_0.s1 v
Exception vector offset: 0x00000020
Exception vector: 0x00000020

|~ Fast TLB Miss Exception Vector
Fast TLB Miss Exception vector memory: |jone

Fast TLB Miss Exception vector offset: 0x00000000

Fast TLB Miss Exception vector: 0x00000000
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28. Kemudian pilih Generate hardware > generate HDI > create HDI design file for
syntseis menjadi verilog > pilih create block symbol file(.bsf) > generate. tunggu
hingga selesai > close > close lagi

Generate View Tools Help
Generate HDL...
Generate Testbench System...
Generate Example Design... >
Show Instantiation Template... >

< Generation X

|. thec

Synthesis files are used to compile the system in a Quartus project.

Create HDL design files for synthesis: Verilog v
D Create timing and resource estimates for third-party EDA synthesis tools.
Create block symbol file (.bsf)

[~ si

The simulation model contains generated HDL files for the simulator, and may include simulation-only features.

Simulation scripts for this component will be generated in a vendor-specific sub-directory in the specified output directory.

Follow the guidance in the generated simulation scripts about how to structure your design's simulation scripts and how to use the
ip-setup-simulation and jp-make-simscript command-line utilities to compile all of the files needed for simulating all of the IP in your design

Create simulation model: None

|~ Output Directory
Path: C:/intelFPGA_lite/18.1/pnios2/pnios2

< >

Generate Cancel

29. Kemudian muncul pemeberitahuan berhasil membuat ip variation in the file > ok 37.
Kemudian pilih Hierarchy

1 #% Hierarchy i

Hierarchy

#' Design Units
" IP Components
@ Revisions

38. Kemudian pilih Files > klik kanan Files > Add / Remove file

T Filers
"""""" % Add/Remove Eiles in Project... ‘

39. Setelah itu pilih Files > pilih Browse > pilih folder pnios2 > synthesis > pilih file
type.qip > Apply > Ok

General Fites |
Files Select the design files you want to include in the project. Click Add All to add all design files in the
Libraries project directory to the project.
Vv IP Settings
IP Catalog Search Locations | File name: | ‘E Add
Design Templates ‘ o X ‘ aa Al

Vv Operating Settings and Conditic

Microcontroller Laboratory

10



Modul Praktikum

40. Kemudian double click pada pnios/sythesis/pnios.v untuk melihat verilognya.
" Files £
v E pnios2/synthesis/pnios2.qip

pniosZ/synthesis/pniosZ.vi

E® pnios2/synthesis/submodules/altera_

[+ SRS\ SRS Sy Yy S ICSCIpIpN Iy rymy iy Pomyusy

41. Kemudian klik kanan pada pnios/sythesis/pnios.v > Set As Top Level Entity >
balik ke Hierarchy

ios2/synthesis/pnios2.vi

BB pnios2/synthesis/sut Open

bl pnios2/synthesis/suk Remove File from Project
o S
%oc pnios2/synthesis/sut @  getas Top-Level Entity ctri+Shift+v

E® pnios2/synthesis/suk
Create AHDL Include Files for Current File

Create Symbol Files for Current File

gm pnios2/synthesis/suk
pnios2/synthesis/suk

E® pnios2/synthesis/suk
— Create VHDL Component Declaration Files for Current File

Create Verilog Instantiation Template Files for Current File

Properties...
racke Camnilatinn

42. Pilih Analysis & Synthesis, hingga selesai

Tasks Compilation v =R x

Task A

v P Compile Design
] >
P> Fitter (Place & Route)

P Ass

>

bler (Generate programn

43. Setelah selesai simulasi, kembali ke halaman awal rangkaian. Pilth menu
Assignments — Pin Planner

Assignments Processing Tools Window Help

® Device..

" settings.. Curi+Shift+E
@ Assignment Editor Ctrl+Shift+A
& rinPlanner Curi+shifteN

Remove Assignments...

- 3

Back-Annotate Assignments...
Impart Assignments...
Export Assignments...
Assignment Groups...

& LogicLock Regions Window  Alt+L

“ Design Partitions Window Al+D

Microcontroller Laboratory
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44. Berikan location di Pin Assignment pada fisik DE10-LITE sesuai dengan datasheet

—Run I/O Assignment Analysis.

& P Pramer N os2

File Edit View

Report bax
o Repor

X

@
Al Groups  Repont

Top View - Wire Bond
MAX 10 - 10M50DAF484C7G

= Tasks
L2 v ly Pin Pl A
. Early Pin Plant =
8 oas
L 0ass
(>} aka
% v akp
HE > Orhac i
* Named: * Edit. Filter: Pins: all
)
#|  NodeName Directon  Locaion  I/OBank  VREF Group itter Locatior /O Standard  Reserved srentStreng ifferential Pal Ict Preservatl
% altera_..ved_tdoOutput PINMS  25V.fauld
ved, PINH2 25V tfaull)
PN 3 8200 PNP1T 25V
PN D14 7 87_N0 PN D14 25V
PNEIA 7 87.N0 PNE1A 25V
PNCI3 7 87.N0 PNLC13 25V
PN D13 7 87_N0 PND13 25V
PNBIO 7 87.N0 PINBIO 25V
PINATO 7 87.N0 PIN.AT0 25V
PNAS 7 87.N0 PNAO 25V
PNAS 7 87.M0 PNAB 25V
PNATE 7 87.M0 PN ATA 25V
PN.ATZ 7 87.M0 PIN.AT3 25V
PN B2 7 87.N0 PNB1Z 25V
PNATZ 7 87.N0 PNAT2 25V
PNC12Z 7 87.N0 PNCI2 25V
PNDIZ 7 87.N0 PNDI2 25V
pNCcT 7 87.N0 PNC1T 25V 12mA _aul)
tch_.porto]  Input PNCIO 7 87.N0 PNCIO 25V 12mA _aul)

Processing Tools Window Help

s Analyzer Tool
=c_>

Start 1/O Assignment Analysis
",_ Enable Live I/O Check

100%

000132

45. Setelah selesai, pilih Assignment > Device > Device and pin options >
configurations > ubah mode menjadi Single Umncomposed Image With Memory

Initialization > Ok > Ok.

Microcontroller Laboratory
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Assignments Processing Tools Window Help

3

Device...
Settings...

Assignment Editor

Pin Planner

o0

Remove Assignments..

I% Back-Annotate Assignments...
Import Assignments...
Export Assignments...
Assignment Groups...

~

% Logic Lock Regions Window
7a Design Partitions Window

+Shift+
Cofsshifc Show in 'Available devices' list
+Shift+
Ctrl+Shift+A Package: i
Ctrl+Shift+N
Pin count: Any

Core speed grade: | Any

Name filter: [

Show advanced devices

Alt+L Device and Pin Options.

Alt+D
>

G Device and Pin Options - pnios2

Category:

Configuration
Programming Files
Unused Pins
Dual-Purpose Pins
Capacitive Loading
Board Trace Model
1/O Timing

Voltage

Pin Placement
Error Detection CRC
P Settings

Partial Reconfiguration

General

Configuration

Specify the device ion scheme and the ion device.

Configuration scheme: |Internal Configuration

e jon mode: [Single Uncompressed Image (3584Kbits UFM)

Configuration device | DUal Compressed images (512Kbits UFM)
single Compressed Image (5888Kbits UFM)
single Compressed Image with Memory Initialization (512Kbits UFM)
7 |Single Uncompressed Image (3584Kbits UFM)
Single Uncompressed Image with Memory Initialization (512Kbits UFM)

[ Force VCCIO to be compatible with configuration 1/0 voltage

VID Operation mode

Configuration pin:

jon Pin Options..

] Generate compressed bitstreams

Description:

Specifies the configuration mode used with the configuration scheme for configuring the device.

oK Cancel Help

46. Compile Design. Tunggu hingga selesai

Tasks Compilation

«quﬁlx

% | v b a

B8 View Report

P> Analysis & Elaboration

Task 2

Microcontroller Laboratory
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47. Hubungkan FPGA DE10-Lite ke Komputer/Laptop

48. Klik Tools > Programmer

Edit
3 r

Project Navigator

File View Project Assignments Processing  Tools Window Help

NamaModul Run Simulation Tool

= S»  “. Launch Simulation Library Compiler
Hierarchy valge x| T

T Launch Design Space Explorer Il
Entity Instance Lt

@

| Timing Analyzer
MAX 10. TOMS0DAF484C7G

EJ namaModul ©8 Advisors

Chip Planner
Design Partition Planner

Netlist Viewers

Signal Tap Logic Analyzer
In-System Memory Content Editor

Logic Analyzer Interface Editor

Tasks Compilation R x

In-System Sources and Probes Editor

Task Signal Probe Pins

v Compile Design

49. Klik Hardware Setup

5 Hardware Setup... ) No Hardware Mode:  JTAG b Progress:
() Enablerealtime ISP to allow background programming when available
U File Device Checksum  Usercode  Program/
= Configure
= output_files/NamaMod... 10M50DAF484 00270F72 00270F72 a2

Verify  Blank-

. |
- pregmmme T

Search altera.corr

L

Examine
Check

* Add Device...

Wy
Up

|

b pown

10M50DAF 484

50. Pada Currently Selected Hardware ganti

Lalu klik Close
2

Hardware Settings JTAG Settings

No Hardware Menjadi

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware:  No Hardware )
Available hardware items
Hardware Server Port Add Hardware...
USB-Blaster Local USe-0
. H
Close
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51. Kemudian centang program/configure, Klik Start, tunggu sampai success
52. Setelah selesai tahap generating hardware, kemudian tahap creating software
menggunakan eclipse, klik tools > Nios II software build tools for eclipse

Tools Window Help
Run Simulation Tool >
Launch Simulation Library Compiler

Launch Design Space Explorer Il

Advisors ¥

2
AN

© Timing Analyzer
Q Chip Planner

Design Partition Planner
Netlist Viewers 4

#  Signal Tap Logic Analyzer
= |n-System Memory Content Editor
= Logic Analyzer Interface Editor
01/ In-System Sources and Probes Editor
Signal Probe Pins...
» Programmer
Q) JTAG Chain Debugger
» Fault Injection Debugger
System Debugging Tools ’

1P Catalog
Nios Il Software Build Tools for Eclipse

e

Platform Designer
# Tl Scripts...

Customize...

Options...
License Setup...
O Install Devices...

100% 000054

Microcontroller Laboratory
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53. Kemudian pilih Workspace sesuai project yang telah dibuat > browse > pilih folder
pnios2 > ok

v pnios2 A
gsys_edit
db
incremental_db
& Workspace Launcher X output_files
Select a workspace pnios2
Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session. unsaved
Workspace: | CAintelFPGA lite\18.1\pnios2 | [CBrowse.. |

Folder: | PniosZ

Make New Falder

[[] Use this as the default and do not ask again

OK Cancel

54. Kemudian terbuka workspace pnios ii — eclipse, pilih file > new > Nios II application
and BSP from template

& Nios Il - Eclipse
File Edit Navigate Search Project Run Niosll Window Help
New Alt+Shift+N > [ Nios Il Application and BSP from Template I
Open File. [¢¥ Nios Il Application
0 [&%] Nios Il Board Support Package
Close = ) )
i ¢ Nios Il Library
O 9 Project...
za“f Qrl+S | Other.. Curi+N |
Ave As r

55. Kemudian pilih file SOPC > browse > pilih file pnios2 .sopcinfo

© Open b4
« v 1 <« Windows (C:) > intelFPGA lite > 18.1 > pnios2 > v O Search pnios2
Organize ~ New folder - @ @
A jiie Data i i
® This PC Name Date modified Type Size
# 3D Objects .metadata File folder
[ Desktop .qsys_edit File folde
[= Documents b File foldet
i File folde
& Downloads incremental_db e folde
output_files e foldel
d Music : .
pnios2 File folde
&= Pictures -
unsaved File folde
__| pnios2.sopcinfo 5/29/2022 11:26 PM SOPCINFO File 223

[ videos

£ Windows (C)

«~~ New Volume (D:

- System Reserved

~ Local Disk (G) v <

SOPC Information File (*sopcin v

File name: | pnios2.sopcinfo v

Cancel
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56. Kemudian project name : pnios2 (sesuaikan nama project quartus) > pilih template
Hello World Small > Finish

& Nios Il Application and BSP from Template ]

Nios || Software Examples

Create a new application and board support package based on a software
example template

Target hardware information

SOPC Information File name: C:\intelFBGA,ITIe\?SRpngsg\pniosz.sopcinfo
CPU name:

pnios2 ~
Application project
Project name: | pnios2
Use default location
Project location: | C\intelFPGA_lite\18.1\pnios2\softwa

Project template

Templates Template description
Hello Freestanding A
Hello MicroC/OS-II

Hello World Small prints 'Hello from Nios II'to A
STDOUT. The project occupies the smallest

Hello World memory footprint possible for a hello world
Hello World Small application.
Memory Test

Memory Test Small This example runs with or without the
R

% 3 MicroC/OS-1I RTOS and requires an STDOUT

57. Maka akan muncul 2 project, double click hello world small.c pada folder pnios2
untuk melihat isi file

© Nios Il - Eclipse

= o x |
File Edit Navigate Search Project Run Niosll Window Help
- m UYL EryGYy BvOvyQvy S 2 < v ¥ > | Quick Acce: (D Nios It
 Project Explorer = £ Outline
v & pnios2 An outline is not available.

& Includes

@ system

& hello_world_small.c
create-this-app
Makefile
readme.txt

& pnios2_bsp

2 Console b k8-
COT Build Console [pnios2]

< /pnios2/hello_world_small.c

Microcontroller Laboratory
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58. Kemudian klik kanan folder pnios2 > build project, tunggu hingga selesai.

on

Build Project

& Build Project [m} X

6 Building project..

Invoking Command: make all

[CJ Always run in background

Run in Background Cancel Details >>

59. Kemudian klik kanan pada file .elf > run.as > nios ii hardware > ketika berhasil
maka akan muncul hellon from nios ii

on

60. pilih Target Connection, lalu Refresh connection, selanjutnya centang “ignore
mismatch system ID” dan “ignore mismatch system timedtamp

)

Microcontroller Laboratory
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61. Klik Apply dan Run.

Lo

© /nonddema/mesddemo ot

62. Berikut adalah hasil nya

P Nios Il Console
pnios3 Nios IT Hardware configuration - cable: USB-Blaster on localhost [USB-0] device ID: 1instance ID: 0 name: jtag_uart_0.jtag

Hello from Mios ITI!
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